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1 Introduction 

1.1 Overview 

As part of the Akrometrix Studio software platform, Surface Measurement is designed 
as the data acquisition package for any Akrometrix hardware utilizing the shadow moiré, 
fringe projection, or DIC techniques. It features a multiple document interface where the 
user interacts with child windows and context menus allowing many types of information 
to be displayed and compared on screen at one time. This manual is intended for use 
with Akrometrix Studio 8.2. 

This manual describes the interface and functions of the Surface Measurement 
software. Automated data acquisition during a thermal profile is described in the Thermal 
Profiler User Manual and analysis is described in the Surface Analysis User Manual. 
Surface Measurement requires system hardware to operate and, thus, will only be 
installed on computers attached to Akrometrix measurement equipment. Surface 
Analysis may reside on the measurement equipment computer and/or on a remote 
computer. 

A user unfamiliar with shadow moiré, fringe projection, and DIC and their application 
in Akrometrix measurement systems is advised to first read Akrometrix Techniques and 
Analysis 101. 

Section 2 describes the program interface and its functions. Section 3 describes the 
program functionality while in DFP mode. Section 4 describes the program functionality 
while in DIC mode. Section 5 describes common problems and troubleshooting. 
Appendix A describes software file formats and keyboard shortcuts. 

1.1 Warnings and Notes 

1.1.1 Warnings and Notes in this Manual 

Warnings and Notes are marked throughout the manual with these icons: 

 

Figure 1.1 Warning Icon 
 

Figure 1.2 Note Icon 

Warnings are specific health hazards for the operator or potential sources of system 
damage. Notes highlight system limitations or automatic responses that may require 
corrective action by the operator for successful operation. 

1.2 Technical Support 

For technical support, contact Akrometrix: 
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Akrometrix 

2700 NE Expressway 

Building B, Suite 500 

Atlanta, GA 30345 

404-486-0880 

404-486-0890 (fax) 

support@akrometrix.com 

http://www.akrometrix.com 

When contacting Akrometrix, please provide the system serial number, the version 
numbers of the Akrometrix software being used, a description of the problem or question, 
and contact information for reply. If the question concerns a particular measurement or 
analysis, please provide electronic copies of the phase images, reference images, and 
final results and a description of data acquisition and/or analysis conditions. If the problem 
concerns changes or failure in general system operation, please describe any events or 
system modifications that occurred immediately before the problem arose. 

mailto:support@akrometrix.com
http://www.akrometrix.com/
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2 Surface Measurement 

2.1 Start-up 

1. Run Surface Measurement by clicking the Surface Measurement button in the 
Studio Manager bar on the left side of the screen. Alternatively, the program can 
be run from the desktop shortcut or by pointing to StartAll 
ProgramsAkrometrixSurface Measurement. A start-up splash screen 
appears while the software initializes.  

2. When asked whether or not to home the grating stage, ensure that all obstructions 
are removed from the stage path and press Yes. If No is pressed, the application 
will continue to load without homing the sample support motors. Homing can be 
accomplished after program start. 

 

Note: Pressing No will decrease program startup time. 
In this case, however, absolute sample support 
position will not be available until the motors are 
homed.  

3. The main Surface Measurement screen will display. The parent window contains 
a camera view and all other windows that the program spawns. 

2.2 Acquiring Data 

1. Position the sample under the grating, using the Camera window (see Figure 2.1) 
to line up edges of the part so that they are more or less parallel with the edges of 
the camera view. 

2. Adjust the region of interest, or ROI, such that it fully encompasses the part to be 
measured. 

 

Note: As of Studio 8.0, multiple independent ROIs can 
be simultaneously acquired. For large numbers of 
identical parts, use Part Tracking as described in 
Section 2.11. 

3. Adjust the sample/grating height using the Sample Height Adjust Window (see 
Figure 2.2) so that there is adequate fringe contrast on the sample. It may also be 
necessary to adjust the camera iris settings to get adequate brightness on the 
sample. Use the highlight saturated and dark pixels options to avoid getting 
saturation in the fringe image. These can be activated by going to the Camera 
Control window described in Section 2.3.2. 
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Figure 2.1 Camera Window, Information Bar Circled  

Figure 2.2 Sample 
Height Adjust 

Window 

4. Right-click on the Camera window to bring up a context menu (see Figure 2.15) 
that contains the Acquire… command. Click Acquire… or, alternatively, press the 
F12 key. 

2.3 Information Bar 

At the bottom of the Camera window (see Figure 2.1), an information bar displays 
relevant acquisition parameters for quick user reference. These include 

 which grating is selected (if more than one is installed on the system) 

 Lateral Resolution 

 the camera exposure time setting 

 the phase amplitude threshold (quality mapping) 

 the digital zoom setting on the camera window 

 the ROI location and size, in pixels, of the currently selected ROI 

 the XY Orientation; Pin 1 Location and Measured Side 

 the Part Tracking ON/OFF setting 

Each one of these parameters, except for digital zoom and Part Tracking, can be 
edited by clicking on the desired parameter. See the following sections for a brief 
description of each parameter and how it can be edited. 

2.3.1 Grating 

The grating parameter area has an arrow on the right side. When clicked, it opens a 
window containing the calibration routines for a grating as well as a grating editor screen. 
See Section 2.8 for instructions on using the calibration routines. 
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When more than one grating is installed on the system, clicking directly on the grating 
information area brings up a grating selection menu. The user can select among the 
available gratings to be the active grating. 

 

Figure 2.3 Grating Pop-Up Menu 

 

Figure 2.4 Edit Grating Window 

 

Figure 2.5 Select Grating Menu 

2.3.2 Lateral Resolution 

 

Figure 2.6 Lateral Resolution Window 

The lateral resolution (number of pixels/unit area) can be defined for the current 
camera/lens setting. This number can be entered by using the current ROI width or height 
(using the W or H buttons) and a known physical width or height value from the current 
sample. Alternatively, if the user knows the current zoom setting that can be entered as 
well. 
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2.3.3 Camera Exposure Time 

The Camera Exposure Time setting shows the current camera exposure time setting 
in percentage form. A Camera Control dialog can be opened by clicking on the Window 
menu at the top of the main screen. This dialog can control the camera exposure time 
setting as well as turn on and off highlighting of dark or saturated pixels. 

 

Figure 2.7 Camera Control Window 

2.3.4 Phase Amplitude 

This section displays whether or not Phase Amplitude Thresholding is turned on, and, 
if so, what its value is set to. Again, this parameter can be edited by clicking on the phase 
amplitude area to open a setting dialog. 

 

Figure 2.8 Phase Amplitude Adjustment Window 

2.3.5 ROI Location 

This section describes where in the field of view the ROI, or region of interest, is 
located and what its size is in pixels. Clicking on this area brings up a dialog that allows 
precise adjustment of the position and size of the ROI. If no ROI is currently selected, this 
section will not be present. 
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Figure 2.9 Edit ROI Window 

 

Note: Regardless of actual ROI shape, the program 
models the ROI as a rectangle when reporting its size 
and location. Location is measured from the top left 
corner of the camera window to the top left corner of 
that rectangle. 

 

Note: Location and size are measured in pixels in 
absolute mode and in fractions of the camera window 
in fractional mode. 

The currently selected ROI can also be adjusted using the following keyboard 
shortcuts when it has focus. Shifting can be done using the arrow keys or the outer 
number keys located on the NumPad. Each press of a key results in one pixel shift of the 
ROI.  

For example: 

Up Arrow or 8 on NumPad Move ROI up one pixel 

7 on NumPad   Move ROI up one pixel and left one pixel 

Holding down Ctrl while pressing any of these keys will increase the ROI size in the 
desired direction. Ctrl+5 will make the ROI its maximum size. Holding down Alt while 
pressing any of these keys will decrease the ROI size in the desired direction. Alt+5 will 
make the ROI half of the maximum length and width and position it in the center of the 
field of view. 

2.3.6 XY Orientation 

For purposes of orienting and registering surface data in Interface Analysis, a new 
section has been added to the Camera Window Information Bar. Clicking on this area 
brings up a dialog where the user can input Pin 1 Location and Measured Side of the data 
that is captured on Acquire. 

 

Note: The current XY orientation setting applies to all 
ROIs present, including Part Tracked regions. 
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2.3.7 Part Tracking: ON/OFF 

This section of the Information Bar simply shows whether Part Tracking is currently 
On or Off. 

2.4 Recipes 

Akrometrix recipe files contain data on various settings to ease set-up for tests which 
are repeated often. These files include ROI location, shape, and size, measurement 
operations like LSF and phase or displacement smoothing, and measurement gauges 
like coplanarity. Regional settings like Phase Amplitude and Smoothing can be varied 
between ROIs within a single recipe, or copied across multiple ROIs. Gauge and 
operation settings can also be varied over different acquisition temperatures if a profile 
has been loaded. 

2.4.1 Loading and Saving Recipes 

The File menu has a Recipe submenu, which contains three options as shown in 
Figure 2.10. 

1. New – Creates a new recipe, resetting all settings to defaults, including one 
rectangular ROI in the center of the camera window. 

2. Load – Loads a saved *.akx_recipe file. 

3. Save – Saves current ROI settings as an *.akx_recipe file. Opens a ‘Save a Recipe’ 
dialog where the save location filename can be chosen. 

 

Figure 2.10 File Recipe Menu 

2.4.2 Editing Recipes 

The Edit Recipe dialog is shown in Figure 2.11. It can be accessed by right-clicking 
anywhere within the camera window and selecting ‘Edit…’ 

 

Note: If Edit is selected from the right-click menu of a 
specific ROI, Edit Recipe opens on that ROI. 
Otherwise, it will default to the first ROI. 

The Edit Recipe dialog has 6 major sections: Menu Bar, ROI Tabs, Temperature 
Tabs, Operations, Gauges, and Layout. 
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Figure 2.11 Edit Recipe Dialog 

1. Menu Bar 

The edit recipe menu bar has three major sections: File, Edit, and Profile. 

File is similar to the Recipe section of the main menu bar, and contains options to 
save the current recipe or load a saved one. 

The Edit menu is shown in Figure 2.12. Its options are detailed below. 

 Units – Sets units in displacement plots to microns or mils. This applies both 
to the data and to any gauges. This value also controls unit expression in 
Thermal Profiler graphs. 
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Figure 2.12 Edit Recipe Dialog - Edit Menu 

 Rename ROI… – Renames ROI corresponding to current ROI tab (not 
available in Profile tab)  

 Copy – Copies chosen settings between all ROIs. Available settings that can 
be copied are shown in Figure 2.12. 

 

Figure 2.13 Copy Settings Dialog 

 Sync Temperature Tabs – When this toggle is active, it syncs the selected 
temperature tabs between different ROIs, so that clicking between ROI tabs 
with a given acquisition temperature selected causes the same temperature to 
be selected in the next ROI tab. This does not affect setting changes. 

Profile allows a saved temperature profile to be loaded into the recipe or removed 
from the recipe. Its third option, ‘Separate Profile Acq Tabs,’ is inactive unless a profile is 
loaded and is described below under Temperature Selection.  

Once a profile is selected, its file path will appear at the bottom of the Edit Recipe 
window. 

2. ROI Tabs 
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This is a series of tabs with each ROI name, as well as a Profile tab, if one has been 
loaded. If Part Tracking is enabled, a ‘Tracked Parts’ tab becomes available. These tabs 
allow the settings for each ROI to be independent of one another but can be synced in 
various ways using the Copy Settings Dialog shown in Figure 2.13. 

3. Temperature Selection 

If no profile is loaded, this section will contain only one tab: On Demand. Without a 
loaded profile, the recipe only holds settings for independent acquisitions for each ROI. If 
a profile is loaded but ‘Separate Profile Acq Tabs’ is not selected, there will be a second 
tab, ‘Profile Acqs’, for ROI settings during the profile run.  

 With a profile loaded and ‘Separate Profile Acq Tabs’ selected, this section will have 
a tab for each acquisition labeled by temperature in addition to the On Demand tab, as 
shown in Figure 2.11. By selecting temperatures here, the user can independently adjust 
the measurement operations for each ROI at various acquisition temperatures. 

4. Operations 

This section displays a list of four possible operations: Phase Amplitude, Smooth 
Phase, Smooth Displacement, and Plane Rotation. Each operation has a default value – 
LSF for Plane Rotation and 0 for the others.  

The operation value can be edited by double clicking the numbers and entering new 
values, or, for Plane Rotation, by choosing a different option from the drop-down list. 
Editing these default values changes the operation for a given ROI. Each operation also 
has a copy button which can propagate its settings to other ROIs or other temperatures 
within the ROI.  

If any operation value is unique within a temperature, ROI, or both, the cell color will 
change. The color codes are listed below.  

 White – Universal setting 

 Orange – Setting exists for all ROIs at the same temperature point. 

 Teal – Setting is unique to a given ROI but exists at all temperature points for 
that ROI 

 Purple – Setting is unique to a single ROI at a single temperature point, or 
setting is shared by multiple ROIs or temperatures, but not universally by 
temperature or ROI. 

 

Note: The colors mark that a unique value exists, not 
which ROI contains that value. For example, changing 
one phase amplitude value in a new recipe turns all 
phase amplitude values purple, even though only one 
has been changed. 

5. Gauges 

Similar to Operations, this section displays a list of current gauges, along with a copy 
button to propagate changes to other ROIs. Gauge values use the same color codes to 
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mark uniqueness as Operations do. Editing gauge settings in the recipe requires a Real 
Time Analysis license to access Pass/Warning/Fail functionality in Surface Measurement.  

 

Note: Real Time Analysis has to be active to see 
gauge results in acquisition, but gauges can be edited 
in the recipe even if Real Time Analysis is not toggled 
on. 

Currently, the only available gauge for Real Time Analysis is Coplanarity. As with 
Operations, the user can activate and alter this gauge by changing its settings. The first 
editable gauge setting is User Defined Name, which applies a custom label to a gauge. 
Editing this changes gauge name wherever it appears, including the 3D graph pane. The 
user can also set low and high warnings and failure limits for the gauge, as well as a 
nominal value for their own reference.  

6. Layout 

This tab allows the user to view and change the size, location, and shape of each 
individual ROI. Size and shape can be copied from the edit menu, but location cannot. 
Location, width, and height can be displayed in absolute or fractional mode, just like ROI 
size and location on the Information bar. 

The shape options are Rectangle, Ellipse, RoundRectangle, Diamond, and Triangle.  

 

Note: RoundRectangle has a set corner radius of 10 
pixels. 

 

Note: Triangle is always isoceles, with the third leg 
oriented horizontally. 

2.5 Camera Window Context Menu 

There are several different commands that can be issued when interacting with the 
Camera window in Surface Measurement. These commands can be accessed by right-
clicking within the Camera window. A slightly different set of commands can be accessed 
by right-clicking on a specific ROI. A full list of the available commands is below. 

 Context Menu (clicked outside an ROI) 

o Acquire… F12 

o Part Tracking 

o File 

o Edit… 

o Add Region Ctrl+R 

o Paste Ctrl+V 

o Default ROI Prefix… 
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o Lock Layout 

o Zoom 

o Save Full Field Image… 

o Open Thermal Profiler… Ctrl+T 

 Selected ROI Context Menu 

o Acquire… F12 

o Zoom to Region 

o Copy Ctrl+C 

o Square Bounds 

o Delete Del 

o Delete All 

o Edit… 

 

Figure 2.14 Camera Window Context Menu - Zoom 

 

Figure 2.15 Camera Window Context 
Menu – Selected ROI 

2.5.1 Acquire 

The Acquire command performs a onetime phase image capture. 

2.5.2 Part Tracking 

From this submenu the user has three options: Enable Part Tracking, Assign Model, 
and Track Parts. These options are described in greater detail in Section 2.10. 

2.5.3 File 

Allows the user to save, load, or create an Akrometrix recipe file as described in 
Section 2.4.  
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The user also has the option to import an *.akx_partition file. The current recipe will 
be replaced with the regions from that file, and the user can choose whether the imported 
regions are scaled to the camera window.  

2.5.4 Edit… 

Opens the edit recipe menu described in Section 2.4. 

2.5.5 Add Region 

Adds a new ROI to the window that can be independently edited. 

2.5.6 Paste 

Pastes a previously copied ROI with the same settings, including location. 

2.5.7 Default ROI Prefix… 

Allows the default prefix for ROIs to be edited. This will apply to any ROIs created 
after the prefix is set, and will restart ROI numbering from X0001, where X is the chosen 
prefix. 

2.5.8 Lock Layout 

If toggled on, locks the layout so that ROIs cannot be changed or added. ROIs can 
still be deleted. 

2.5.9 Zoom 

Allows the Camera Window to be digitally zoomed and resized in various ways. 

2.5.10 Save Full Field Image 

This command will save an image in *.png format of exactly what the user sees within 
the Camera window, ROI included. 

2.5.11 Open Thermal Profiler 

This command opens a separate application in the Studio Suite called Thermal 
Profiler. This allows automated data capture while subjecting the sample to a thermal 
profile. For more details please see the Thermal Profiler User Manual. 

2.5.12 Zoom to Region 

Zooms the camera view to the region of the selected ROI. 

2.5.13 Copy 

Copy the settings, including location and size, of the selected ROI. 

2.5.14 Square Bounds 

Forces the ROI to be square using the smaller of its two dimensions. 
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2.5.15 Delete 

Deletes the selected ROI. 

2.5.16 Delete All 

Deletes all ROIs. 

2.6 Results Window 

 

Figure 2.16 Results Window 

Phase and Displacement data are displayed after acquisition in a multi-port window 
with tabs for different data display types. There are several different commands that can 
be issued when interacting with the Results Window. These commands can be accessed 
by right-clicking within either the camera side or data side of the window. 

The Results Window can display results for all currently tracked ROIs. To switch 
between ROIs in the data side, either click on the desired ROI in the camera side or use 
the arrows at the bottom of the data side display to move between ROIs. The active ROI 
will be highlighted in the camera side display. 

2.6.1 Camera Side Display 

This section of the window displays the camera surface image and all ROI locations, 
including any found via Part Tracking. The view can be zoomed to the extents of the ROI 
locations. Phase or Displacement data can be overlaid on the surface image at the ROI 
location or locations in the case of Part Tracking. Lastly, the current image or overlay can 
also be saved. 

2.6.2 Data Side Display 

The data display side of the window has 4 tabs, as well as an information bar at the 
bottom. The information bar displays the current ROI on a selection dropdown, two arrows 
that switch between multiple ROIs, and a readout of the minimum and maximum phase 
amplitude that allows a user to quickly assess the data. 
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Figure 2.17 Data Side - Surface Tab 

 

Figure 2.18 Data Side - Phase Tab 

2.6.3 Surface Tab Context Menus 

 ViewSurface Or Intensities 1-4 

 Save Image…   Ctrl+I 

Saves the surface image as a *.png image file. 

 Save All… 

 

Figure 2.19 Save All Dialog 

The Save All dialog allows the user to save all available data types from the Results 
Window at once. In Part Tracking mode, this allows all found regions to be saved as 
well. 

 Rename Window… 
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Allows the user to rename the Results Window to something other than the default 
date/timestamp. 

2.6.4 Phase Tab Context Menus 

 Open in Surface Analysis… 

Opens the phase image in Surface Analysis. The file is not saved to disk at this point 
so the user will still need to save the image if long term storage is required. 

 FileSave… 

Saves the phase image as a *.akx_phase file which can be analyzed using Surface 
Analysis. The phase image name is constructed from the date and time at acquisition, 
but can be changed by the user 

 FileSave Image… 

Saves the phase image as either a *.png or *.tif image file. 

 FileSave All… 

 Properties… 

Opens the metadata view for the phase data associated with the acquisition. 

 Rename Window… 

 

Figure 2.20 Data Side - Displacement Tab 

 

Figure 2.21 Data Side - 3D Graph Tab 

2.6.5 Displacement Tab Context Menus 

 Common Z-Scale 

Sets all current displacement data to the same Z-scale. This option is not available 
when there is only one ROI. 

 FileSave… 

Saves the displacement data as a *.akx_disp file which can be analyzed using 
Surface Analysis. The displacement file name is constructed from the date and time 
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at acquisition, but can be changed by the user. The displacement data can also be 
saved for use in external programs in the *.dat or *.txt formats. 

 FileSave Image… 

Saves the displacement image as a *.png image file. 

 FileSave All… 

Opens the Save All… dialog described above. 

 Properties… 

Opens the metadata view for the displacement data associated with the acquisition. 

 Open in Surface Analysis… 

Opens the 3D surface image in Surface Analysis. The file is not saved to disk at this 
point so the user will still need to save the image if long term storage is required. 

 Rename Window… 

2.6.6 3D Graph Context Menus 

Same as Displacement Tab above. 

2.7 File Menu Bar 

At the top of the Surface Measurement application window there is a standard 
Windows File Menu bar (see Figure 2.22). It contains the following menu categories: 

 File  Tools  Thermal Profiler  Window  Help 

2.7.1 File 

The File menu will change depending on what type of window has focus. It will have 
relevant commands for the currently selected window type. For example, if the Camera 
window is selected, it contains an Acquire command, a Save Full Field Image command, 
a Recipe command (see Section 2.4 for details), and an Exit command. 

 

Figure 2.22 File Menu 

2.7.2 Tools 

The tools drop down menu contains several items, as described below. 
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Figure 2.23 Tools Menu 

 Manage Gratings – Allows the user to add or remove gratings from the 
system. 

 Home… - Allows the user to home the system motors if that step was skipped 
during program start. 

 

Note: Absolute motor position is not available unless 
the motors have been homed. Some features in 
Thermal Profiler, like frame compensation in CRE 
mode and lower while heating require the motors to be 
homed before they are available. 

 Accuracy Check – Allows the user to check the measurement accuracy of a 
normal step height block (see Section 2.8.3).  

 Real Time Analysis – Activating this toggle requires a Real Time Analysis 
license. When it is active, the user can set pass/warning/fail limits in the recipe 
(see Section 2.4.2) and determine immediately whether the analyzed parts 
have gone beyond acceptable bounds. In the camera window after acquisition, 
ROIs will be colored red (Fail), yellow (Warning), or green (Pass) based on the 
gauges instead of the default blue. When this is active, the Gauge Results 
Summary also becomes available (see Section 2.7.4) 

 Autosave Settings – Allows the user to control autosave settings for phase 
and displacement measurements acquired in this program. Metadata settings 
can be used to populate filenames, as shown in Figure 2.24. See Appendix 
A.1.1 for available Metadata fields. 
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Figure 2.24 Autosave Settings 

 Options… - Opens system options as described in Section 2.9. 

2.7.3 Thermal Profiler 

As Figure 2.25 shows, this menu allows the user to open Thermal Profiler. 

 

Figure 2.25 Thermal Profiler Open Menu 

2.7.4 Window 

This menu item contains commands for managing the child windows that are present 
within the parent Surface Measurement window at any time. Windows that may be hidden 
behind other windows can be brought to the foreground by selecting them in this drop 
down menu. All open windows can also be closed by selecting the Close All Windows 
command. The Metadata, Camera (Section 2.2), Sample Height (Section 2.2), Camera 
Control (Section 2.3.2), and Part Tracking (Section 2.10) windows are always available 
in this menu. 

The metadata window is shown in Figure 2.26, and can also be accessed by pressing 
F4. It allows the user to set metadata values, which are useful in populating filenames 
and organizing data, for the samples being measured. This window also allows the user 
to set certain metadata values as required. Required metadata values are cleared after 
each acquisition, and must be entered for more acquisitions to be taken. This function 
therefore automatically reminds the user to update metadata settings between 
acquisitions. 
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Figure 2.26 Metadata Window 

When the results window is open, an option appears at the bottom of the Windows 
menu to bring it to the front. This option has the name of the results window – a time 
stamp by default, unless changed by a user. It is visible in Figure 2.27. 

When Real Time Analysis is active, an additional window, Gauge Result Summary, 
becomes available. It will appear on the Window menu under Part Tracking, and can also 
be opened by pressing F11. Opening Gauge Result Summary produces the interface 
shown in Figure 2.28. It will show the gauge results for all ROIs for all acquisitions since 
the most recent change in the ROI settings. The Options menu allows the user to copy or 
reset the gauge data, or export it to Excel. In the Gauge menu, the user can choose 
between any active gauge or a combination of all of them. The part passes if it passes all 
gauges, and fails if it fails any. 

 

 Figure 2.27 Window Menu 
 

Figure 2.28 Gauge Result Summary 

2.7.5 Help 

This menu item contains a link to the Surface Measurement User Manual, the End 
User License Agreement (EULA), and an About… command for determining program 
version information. 

2.8 Grating Calibration Routines 

The grating calibration routines can be accessed by clicking the small arrow to the 
right of the Grating information area on the Information bar (see Figure 2.29). Clicking on 
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either one of these items will put the system in the respective calibration mode. The user 
must deselect the calibration mode when calibration is complete. 

 

Figure 2.29 Grating Pop-Up Menu 

2.8.1 DAQ Fringe Height 

In the Calibrate DAQ Fringe Height mode, a uniform white colored continuous 
surface sample is used to determine the optimal phase step distance based on the optical 
configuration of the system. The calibration sample is provided by the user and can be 
any white colored, continuous surface sample that is at least 100mm x 100mm. The 
sample must also be sufficiently stiff so as to maintain its shape while phase stepping 
occurs. 

1. When Calibrate DAQ Fringe Height mode is enabled the ROI bounding box 
becomes a dashed outline.  

2. After placing a uniform white colored continuous sample in the measurement 
system, adjust the ROI such that it only encompasses a continuous part of the 
sample. 

3. Right click to select Start Calibration… from the Camera window context menu. 
A series of images is taken with different step heights to determine the best 
calibrated phase step distance, or DAQ Fringe Height. While the images are 
being taken a dialog (see Figure 2.30) pops up showing the captured images and 
a plot of the intensity standard deviation for each step height trial. 
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Figure 2.30 DAQ Fringe Height Cal Dialog 

4. At the completion of the calibration routine a dialog pops up asking the user to 
update the DAQ Fringe Height. 

 

Note: The DAQ Fringe Height plot should be roughly 
parabolic in shape. If there is no distinct minimum, 
vibration or some motor stepping error could be 
present. 

5. Press Yes to approve and save the new DAQ Fringe Height. If an error is 
suspected (refer to Section 5.1), press No to discard the new calibration value. 

 

Note: The resulting value should be roughly equivalent 
to the grating pitch. 

2.8.2 Fringe Value 

In the Calibrate Fringe Value mode, a single step calibration block is used to 
determine the Fringe Value calibration constant for the system. This block is provided 
with the measurement system. See Akrometrix Techniques and Analyses 101 for more 
details on this calibration constant. 

1. Enter the calibration offset value in the Calibrate Fringe Value dialog box (Figure 
2.33) that pops up and click OK. The calibration offset value for the block is on the 
Calibration Certificate provided with each block. Please note that the relevant 
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number will either be listed as “Distance” or “DIST_A_to_B” depending on what 
independent lab was used to calibrate the block. Please see Figure 2.31 and 
Figure 2.32. 

 

Figure 2.31 Offset Value from Certificate 
(Quindos) 

 

Figure 2.32 Offset Value from Certificate (ATS) 

2. Adjust the ROI such that the outside square approximately outlines the calibration 
block (Figure 2.34). Exact alignment is not required because measurements are 
made only within the inner two rectangles, which are inset from the outside 
boundary.  

 

Note: The calibration block step needs to run 
horizontally, or from left to right when looking down 
from the user’s position at the machine, but it does not 
matter whether the top or bottom step is in front or 
back. 

 

Figure 2.33 Offset Value Dialog  

Figure 2.34 Fringe Value ROI on cal block 

3. Right click within the ROI and click Acquire… The calibration process is initiated 
and a result window pops up afterward (Figure 2.35), showing the user entered 
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value, the measured value, the old Fringe Value, and the proposed new Fringe 
Value. 

 

Figure 2.35 Fringe Value Result 

4. Press Yes to approve and save the new Fringe Value. If an error is suspected 
(refer to Section 5.1), press No to discard the new calibration value. 

 

Note: The Fringe Value should be roughly equivalent 
to the grating pitch. If the routine is performed more 
than once, the value should vary less than the grating 
resolution (± 0.1 mils or 2.5 microns). If it does not, then 
vibration or some motor stepping error could be 
present. 

2.8.3 Accuracy Check 

Under the Tools menu at the top of the program there is an Accuracy Check 
function, which is used for checking the normal height between two surfaces. This is 
useful for checking system accuracy against a cal block with a machined step height in it. 
Typically, the accuracy check measurement is compared with that of a CMM or laser 
based profilometer measurement. 

2.9 Software Options 

Surface Measurement options can be accessed by going to Tools → Options. A 
Dialog appears as in Figure 2.36. 
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Figure 2.36 Options Dialog 

2.9.1 Algorithm 

Allows the user to specify either the Fixed Shift or Random Shift phase shifting 
algorithm. See Akrometrix Optical Techniques and Analyses 101. The default is Fixed 
Shift and is the correct choice in most situations. 

2.9.2 Delay per Step 

Determines the amount of time in milliseconds the software waits between each 
phase step. Increasing this value can be useful for samples that exhibit excessive 
vibration between each phase step. Keep in mind, however, that increasing this value will 
increase total data acquisition time. 

2.9.3 Show Graph Axes In Pixels 

If Lateral Resolution has been specified, the default setting of False will show 3D 
graphs’ x and y axes in physical units instead of pixels. 

2.9.4 Surface Units 

Determines what units the Surface Windows display in. Options are mils or microns. 

2.9.5 Position Units 

Determines what units the Sample Height dialog displays the current motor travel 
position in. Options are mils or microns. 

2.9.6 Close All Windows on Acquire 

On Acquire, closes all open result windows within the Surface Measurement parent 
window. Setting this to false will spawn a new result window on each Acquire. 
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2.10 Part Tracking 

Part Tracking is a feature in Akrometrix Studio which has the potential to reduce 
analysis time of multiple part runs by more than 90%. It is designed to find and track 
rectangular or elliptical parts of a user defined size at room temperature and during a 
temperature profile. Traditionally, if a part happened to shift or rotate during a thermal run, 
the user would need to spend many painstaking minutes manually partitioning and 
rotating the data such that the resulting displacement plots did not have any artifacts. 
With Part Tracking, all the resulting data at the end of a thermal run should automatically 
be partitioned and rotated to the same starting orientation, greatly speeding analysis time. 
Part Tracking even improves work flow and productivity when only one sample is tested 
and moves due to thermal expansion. The more samples tested at once, the more 
productivity will be improved. 

2.10.1 Part Tracking Window 

 Shape – Defines the shape and size of the model that Part Tracking will try to 
find parts with. The model shape and size is represented by the white box on 
the right side of the Part Tracking window. 

o Shape – The part shape can be selected from this drop-down. The 
supported options are Rectangle and Ellipse. 

o Size – This is the width and height of the model. The size can be 
buttoned in manually or set from the ROI/Search Area context menu. 

 Search Settings 

o Number of Instances – Defines the number of parts which Part 
Tracking should expect to find. In order to eliminate finding “ghost” 
parts, Akrometrix recommends setting this to the exact number of parts 
in the oven. The max number of instances is 999. 

o Rotation – Defines the rotation tolerance for finding a part. This will 
allow parts to be found which aren’t perfectly aligned with the camera 
pixels. Akrometrix recommends setting parts up such that they are 
within 10° of normal to the camera and using as little rotation tolerance 
as possible. Increasing this value can increase the risk of finding “ghost” 
parts. The max rotation tolerance is 30°. 
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Figure 2.37 Part Tracking control window in Surface Measurement 

o Scale – Defines the scale tolerance for finding a part. This will allow 
parts to be found which aren’t exactly the same size as the model. This 
can be useful when comparing results between systems that have ever 
so slightly different zoom factors. For example, a scale tolerance of 2% 
on a rectangle model of 168 x 168 pixels will allow Part Tracking to find 
parts which are anywhere from 165 x 165 to 171 x 171. Increasing this 
value can increase the risk of finding “ghost” parts. 
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o Minimum Match – This defines the percentage of edge which Part 
Tracking has to find to determine that a feature in the camera image is 
a part. Decreasing this setting will increase the risk of finding “ghost” 
parts. 

o Part Color – Allows part tracking of black (dark) colored parts on a 
white background. This is mainly for use with samples than cannot be 
painted. 

 Naming – This allows the user to set custom ROI names for tracked regions. 
The default is PTXXXX, starting at PT0001. 

o Auto – Allows user to enter custom prefixes and suffixes for ROI 
names. 

o User Defined – Allows the user to set custom names for individual 
parts. Right click in the gray area to add lines or import a text file of 
return separated values. 

 Inset (pixels) – Determines the number of pixels to crop in on found parts. 
This will effectively reduce the ROI on a part and can be useful for reducing or 
eliminating edge displacement artifacts. A different inset value can be 
specified for each side by unchecking the Sync option. 

 Target Image 

o Increase Contrast – Increases the contrast of a surface image before 
part tracking occurs. This can be useful for finding parts which have low 
contrast with the oven background. 

All of the settings above can be saved in a part tracking file known as *.akx_track. 
This allows settings to be reused from run to run and site to site without having to manually 
enter every setting. 
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Figure 2.38 Part Tracking File Menu 

 

Figure 2.39 Part Tracking Options Window 

 

Figure 2.40 Part Tracking View Menu 

 

 File Menu – Load and Save *.akx_track files as well as Open previously saved 
Target Images which can be either *.bmp or *.akx_phase 

 Options – Allows the user to retain acquired target images in memory so that 
the part finding options can be experimented with to find the appropriate 
number and location of parts. 

 View – Allows the user to show or hide the Model and Target Images display. 
See the result with both being shown in Figure 2.41. 

Part tracking can be performed on ‘Target Images’ which are previously saved phase 
images of the entire search area. This allows the user to try different part track settings 
on an input file which is constant. When part tracking is performed on a newly acquired 
phase image, small changes in image noise can result in varying behavior if the samples 
have low contrast to their background. Keeping the input phase image constant allows 
more nuanced testing of different settings without camera noise coming into play. 

 

Note: If Part Tracking is enabled, the Search Area box 
in the Camera window will affect the search area inside 
the loaded Target Image(s). If it is disabled, the entire 
Target Image is searched. 
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Figure 2.41 Part Tracking window with Target Image 

 

Figure 2.42 Target Image Tab Menu 

 

Figure 2.43 Target Image Context Menu 

In the Target Images display section of the Part Tracking window, there are two more 
right-click context menus available to the user. The user can close tabs using the context 
menu shown in Figure 2.42, as well as search and save Target Images using the menu 
shown in Figure 2.43. 
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2.11 Part Tracking Quick Guide 

1. Enable Part Tracking in either the Part Tracking Window (Figure 2.37) or Camera 
Window context menu (Figure 2.14). 

2. Align at least one of the parts to be measured such that it is normal (square) to the 
camera pixel grid. 

3. Size the blue, dotted-line ROI such that it contains all parts that will be tracked. 
Right click inside this ROI and click ‘Assign Rectangle Model’ (Figure 2.44). 

4. Size the yellow ‘Model’ ROI so that it exactly contains one of the parts. Right click 
on the model ROI and select ‘Set rectangle model size’ (Figure 2.45). 

 

Note: If Shape is set to Ellipse, these options will read 
‘Assign Ellipse Model’ and ‘Set ellipse model size’. 

5. Choose the desired Part Tracking settings, including # of parts to be found, 
expected maximum rotation from normal to the camera pixel grid, inset, etc. 

 

Note: Part tracking is compatible with ordinary multi-
ROI functionality. Use the commands from Section 2.5 
to add, remove, or edit additional ROIs (Figure 2.47).  

6. Right click on the camera window and click Acquire (Figure 2.45). 

 

Note: Instead of immediate acquisition, which may 
incur a large processing time with large numbers of 
parts, the user can check part tracking settings by right-
clicking on the camera context window and selecting 
the ‘Track Parts’ option shown in Figure 2.44. The 
currently tracked parts will be shown outlined in orange 
as shown in Figure 2.46. The same tracking display 
will be seen after a normal acquisition with Part 
Tracking enabled. 
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Figure 2.44 Assign Model 

 

Figure 2.45 Set Model Size 

 

Figure 2.46 Tracked Parts 

 

Figure 2.47 Part Tracking and Static ROIs 
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3 DFP Surface Measurement for AXP 

The interface and operation of the DFP Surface Measurement program are very 
similar to the Surface Measurement program. A user unfamiliar with the Surface 
Measurement software should read Section 2 first or refer to it where necessary for 
operation of the DFP software. In this section, only DFP specific functions will be 
described. 

In the DFP module, a digital projector is software controlled for displaying and phase 
shifting fringes on the sample surface.  

 

Note: The sample height adjustment stage is still in 
use. Instead of executing phase shifting, it is used to 
move the sample vertically for focusing purposes. 

3.1 Start-up 

1. Remove the TherMoiré grating from the oven lid if it is in place. 

2. Install the DFP module. (Refer to the DFP User Manual). 

3. Run the DFP Surface Measurement program by clicking the corresponding button 
on the Akrometrix Studio Manager toolbar on the left side of the screen. A start-up 
splash screen appears while the software initializes.  

4. When asked whether or not to home the grating stage, ensure that all obstructions 
are removed from the stage path and press Yes. If No is pressed, the application 
will continue to load without homing the sample support motors. 

 

Note: Pressing No will decrease program startup time. 
In this case, however, absolute sample support 
position will not be available.  

5. The main screen will display and it looks very similar to the normal Surface 
Measurement interface.  

3.2 Calibration 

Akrometrix believes that calibration should be performed whenever: 

 The DFP system is initially installed 

 Individual optical components, such as the projector, or video camera have 
moved 

The following procedure assumes that the system has already been aligned 
according to the DFP User Manual and requires the use of a white painted optical flat 
(Figure 3.1) provided with the system. 
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1. Place the flat in the system on the normal sample support rails at roughly the 
middle of the depth of focus. 

 

Figure 3.1 White Painted Optical Flat 

 

Note: Avoid touching the top surface of the optical flat. 
Doing so could leave fingerprints or scratches on the 
surface and result in measurement errors. Carry the 
flat by its edges and store it safely when not in use. 

2. Jog the flat up or down to ensure that the ends of the vertical line from the projector 
crosshairs line up with the ends of the software crosshairs as closely as possible. 
This ensures the block is in the middle of the depth of field. See Figure 3.2. 

 

Note: The projector vertical crosshair line may appear 
somewhat curved; this is a normal consequence of 
lens distortion and is accounted for in the system 
calibration.  
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Figure 3.2 Projector and Software Crosshair Alignment 

3. Press the Calibrate button on the bottom left of the Camera Window. The system 
will jog the optical flat down and then back up using the sample support stage. 
Measurements are taken along the way and a calibration profile including lens 
distortion is created. A dialog shows calibration progress (Figure 3.3). When the 
calibration is complete a second dialog will confirm if the user wants to accept the 
new calibration results. 
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Figure 3.3 Calibration Progress Window 

3.3 Accuracy Check 

Accuracy checks can be performed on the Akrometrix supplied calibration block by 
utilizing the step height functionality in Surface Analysis. See the Surface Analysis 
User Manual for more information. 

3.4 Software Options 

DFP Surface Measurement options are the same as in Section 2.9 with the exception 
of the Smooth Displacement option which runs a smoothing algorithm on the 
displacement data. Also, the delay per step and algorithm options are not available here. 
See Akrometrix Optical Techniques and Analyses 101 for more details. 

 

Figure 3.4 DFP Surface Measurement Options 

3.5 Software Operation 

DFP Surface Measurement and Thermal Profiler work very similarly to the standard 
versions. The user interacts with the same context menu commands in the Camera 
window as in Section 2.4, with the exception of the Show Crosshairs and Accuracy 
Check… commands. 
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4 DIC Surface Measurement 

The interface and operation of the DIC Surface Measurement program are very 
similar to the Surface Measurement program. A user unfamiliar with the Surface 
Measurement software should read Section 2 first or refer to it where necessary for 
operation of the DIC software. In this section, only DIC specific functions will be described. 

Because the DIC technique is fairly different than that of shadow moiré or fringe 
projection, the program interface is much simpler than for those techniques. No analysis 
or calibration functions exist in this software. The only major function available is to 
acquire images from both cameras simultaneously. 

 

Note: The system sample height adjustment stage is 
still in use. Instead of executing phase shifting, it is 
used to move the sample vertically for focusing 
purposes. 

4.1 Start-up 

1. Remove the TherMoiré grating from the oven lid if it is in place. 

2. Install the DIC module. (Refer to the DIC User Manual). 

3. Run the DIC Surface Measurement program by clicking the corresponding button 
on the Akrometrix Studio Manager toolbar on the left side of the screen. A start-up 
splash screen appears while the software initializes.  

4. When the Homing Sequence Confirmation Dialog is displayed (Figure 4.1), press 
Yes to continue program initialization. The TherMoiré sample support stage will 
home. 

 

Figure 4.1 Homing Sequence Confirmation 
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5. The main screen will display and it looks very similar to the normal Surface 
Measurement interface, except that it has two camera views instead of one (Figure 
4.2). 

 

Figure 4.2 DIC Surface Measurement 

6. Right-click anywhere in the Camera window to Acquire data or change the camera 
zoom factor. 

4.2 Software Options 

A simplified options dialog (see Figure 4.3) is available in ToolsOptions, just as 
in normal Surface Measurement. There are no new options. The only difference with 
respect to normal Surface Measurement is that options that do not apply have been 
removed.

 

Figure 4.3 DIC Options Dialog 
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4.3 System Calibration 

Calibration of the stereo system requires capturing 15-20 images of a calibration 
target in different rotations for each image. This is accomplished by the following 
procedure: 

1. Setup the DIC system as described in the DIC User Manual. 

2. Position the calibration target underneath the cameras’ FOV. 

3. Capture an image of the calibration target, then rotate the target. Repeat 15-20 
times. The images will pop up, one on top of the other. 

4. Save the images into a project folder by using the FileSave All… command. 
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5 Troubleshooting 

5.1 Troubleshooting Data Acquisition 

As with any measurement system, Akrometrix TherMoiré products have their 
limitations. These limitations exist because the shadow moiré technique with phase 
stepping analysis is sensitive to the optical properties of the samples measured. The 
optical and analytical limitations of the system include: 

 Failure to obtain good fringe phase information. 

 Loss of resolution on samples with a wide range of reflectivity. 

5.1.1 Failure to Obtain Quality Phase Information 

Phase information is obtained for each pixel in an image by combining four images 
on a pixel-by-pixel basis. In general, quality phase information can be obtained anywhere 
good fringe contrast is observed in the raw video image. Frequently, good phase 
information can be calculated even where the human eye cannot resolve fringes; for 
example, against a permanent background pattern such as circuit traces. However, there 
are situations where quality fringes cannot be obtained: 

Symptoms: 

 An extremely noisy grayscale signal appears in the phase image. (Figure 5.1) 

 A banding pattern of grayscale values appears in the phase image.(Figure 5.2) 

 Discontinuities exist in the calculated displacement data. (Figure 5.3) 

 

Figure 5.1 Noisy Phase 
Image 

 

Figure 5.2 Banded Phase Image 

 

Figure 5.3 Discontinuity Errors in 
Displacement Data 

Cause: Discontinuous Sample 

Fringes are not generated at holes and cutouts or where the sample surface is 
shadowed by components or other obstructions; fringes can only appear on the sample 
surface itself. While these are obvious statements, the problems resulting from nonsense 
phase calculations within such localized regions frequently cause incorrect interpretation 
of the phase image. 

Surfaces with abrupt discontinuities, such as steps, components, or solder balls, can 
create analysis errors characterized by sharp diagonal edges in the calculated 
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displacement surface (Figure 5.3). For shadow moiré, abrupt implies adjacent pixels with 
a height difference greater than half the fringe value, e.g. greater than 0.005” (0.127 mm) 
for a 100 line per inch grating or 0.0017” (0.043 mm) for a 300 lpi grating. 

Solution: 

a. Use the Phase Amplitude option with an appropriate threshold value to 
automatically eliminate bad pixels from the phase image. 

b. Use a grating with a larger pitch, e.g. a 100 lpi grating instead of a 300 lpi. 

c. Apply a user-defined mask over holes and slots using Surface Analysis. See 
the Surface Analysis User Manual for more details. 

d. Within the Surface Analysis program, vary the filter conditions. 

Cause: Incorrect Phase Step Distance 

An incorrectly assigned phase step size results in the incorrect calculation of phases. 
This is due to incorrect software grating selection, incorrect calibration values, or physical 
contact between the sample and the grating. If the sample support frame is raised so that 
the sample is touching the grating, the sample is not uniformly translated relative to the 
grating during the phase stepping data acquisition. 

The grating is touching the sample (more generally, some point on the lid is touching 
some point on the sample support fixture), so that the grating does not translate 
independently of the sample during phase stepping. The phase image frequently has the 
appearance of Figure 5.2. Use the Sample/Grating Height adjustment dialog to manually 
raise and lower the sample at Slow Speed. If the sample is touching, the fringe pattern is 
frozen at some or all points on the sample. 

Solution: 

a. Lower the sample, or raise the grating, so that they are not touching. 

b. Check to make sure the correct grating is selected from the drop down list in 
the software. 

c. Open the calibration file and check that the grating value is within ±10% of the 
theoretical value. If not, perform calibration. 

Cause: Sample-Grating Distance 

A fringe pattern is not visible when the distance between the sample surface and the 
grating is too large. There is an effective working distance below the grating within which 
fringes on the sample surface can be observed. The shadow of the grating loses 
sharpness as the distance from the grating increases due to diffraction effects and finite 
thickness of the light source. As a rule of thumb, these distances are approximately: 

 0.8 in (20 mm) for the 50 lpi grating  

 0.2 in (5 mm) for the 100 lpi grating, and  

 0.02 in (0.5 mm) for the 300 lpi grating. 

Solution: 
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Adjust the height of the sample, either with the servomotor stages or by changing the 
sample support fixture. Position the sample so that it shows a high contrast fringe pattern 
on the raw video feed, but is not touching. If the sample is translated from this point using 
the servomotor stages, the user observes that the fringe pattern moves smoothly and 
uniformly across the sample. If some part of the fringe pattern does not move during 
translation, this usually indicates that that part of the sample is touching the grating. 

In some cases, it may not be possible to bring the sample surface within working 
distance of the grating, e.g. with a tall component or connector on the sample surface. 
Approaches Akrometrix has used under these circumstances include: 

 Inverting the sample and measuring the back surface, or 

 Using a lower resolution grating with a larger working distance. 

Cause: Unfavorable Surface Optical Properties 

The surface has unfavorable optical properties. Shadow moiré is based on diffuse 
reflection from the sample surface, which allows the interference patterns between the 
shadow grating and the reference grating to be observed. Surfaces that provide poor 
diffuse reflection include: 

 transparent surfaces, such as glass 

 specular reflecting surfaces, such as polished metal or solder pads 

 black or other dark-colored surfaces 

Solution: 

a. Using the Phase Amplitude option with an appropriate threshold value 
automatically masks regions with such unfavorable optical properties, 
excluding these bad pixels from the phase image and subsequently the 
analysis calculation. 

b. Painting the sample with a thin coat of high temperature white paint provides 
optimal surface properties for shadow moiré without significantly affecting 
mechanical properties. Other surface treatment methods may be used, 
depending on the sample, including creating a matte finish on a metal surface 
by etching or abrasion. 

c. Blurring the focus of the camera can help in some circumstances. For example, 
blurring allows a strong fringe signal from the terminal ring around a through-
hole to combine with the weak fringe signal from adjacent regions of solder 
mask. This technique does reduce the lateral resolution of the measurement. 

Cause: Stray Sample Illumination 

Illumination of the sample by any light other than the linear fiber optic light source 
decreases the shadow contrast. In addition to ambient light, frequent sources of additional 
light are reflections inside the sample chamber and light from the infrared heating source. 

Solution: 

a. Close system doors & turn off room lights. 
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b. Shield off as much of the heater light as possible by laying black paper or cloth 
shields on top of the oven window. 

c. Make sure that the IR filter is in place on the camera lens. In extreme cases, 
shield off as much of the heater light as possible by laying black metal, paper 
or cloth shields on top of the oven window. 

5.1.2 Additional Sources of Error 

Several second-order effects have been observed in phase-stepped shadow moiré 
measurements that can affect results, particularly for extremely small and/or flat samples. 
Periodic structures in the apparatus or samples can introduce corresponding periodic 
errors in the phase image. In addition, the phase calculation algorithms inside Akrometrix 
software can introduce small periodic errors.  

High magnification of the sample can cause the grating lines themselves to be 
resolved, which can cause a periodic error in the phase calculation. Choose a 
combination of magnification and grating frequency so that the lateral resolution is at least 
one full grating pitch. The general guidelines below minimize this problem: 

1. If the full field of view of the video image is less than 160 mm in width, use a 100 
lpi or higher grating. 

2. If the full field of view of the video image is less than 60 mm in width, use a 300 lpi 
or higher grating. 

Even when these guidelines are used, interference between camera pixel spacing 
and grating line spacing can produce aliasing in the video image. This initially appears as 
low contrast vertical (or near vertical) fringes across the image that vary in pitch and 
rotation as the zoom lens magnification is varied. This effect can be minimized by varying 
the lens magnification. 

Interference between a periodic structure on the sample surface (e.g. a field of 
solder pads on a BGA substrate) and the grating line spacing can introduce a periodic 
phase calculation error. This effect can generally be observed by eye in the live video 
image of the sample and may be eliminated by re-orienting the sample or changing the 
grating (e.g. from 100 lpi to 300 lpi). 

A second problem related not to system hardware, but to system software is 
caused by the breakdown of the sinusoidal approximation used in the phase calculation 
(see Akrometrix Techniques and Analysis 101). This appears as a series of ripples 
superimposed on the final displacement results. The ripples are characteristically parallel 
to the fringes appearing in the shadow moiré fringe pattern, but at four times the fringe 
frequency (a similar effect occurs when an incorrect step height is used, but the frequency 
of ripples is two times the fringe frequency). 

In general, the amplitude of the ripples is comparable to the resolution of the system 
and the effect on accuracy is within the system specification. However, saturation of the 
video camera by regions of high reflectivity can enhance this effect to higher levels. If 
observed, this effect may be reduced through elimination of camera saturation by closing 
the lens iris or reducing light source power. In some cases, the effect may also be reduced 
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by slightly increasing the distance between sample and grating. Consult with Akrometrix 
technical support if this effect is creating significant measurement problems. 

5.1.3 Loss of Contrast and Resolution 

A more subtle concern in making phase-stepped shadow moiré measurements deals 
with the relationship between the digital resolution of the intensity measurements and the 
precision of the vertical displacement data. The high resolution of the phase stepping 
method is based on the number of grayscale levels available when the fringe pattern is 
digitized. Using a 12-bit digitizer (new as of Studio 8.0), there are 4,096 grayscale levels 
to encompass the fringe pattern from its brightest to darkest pixel. These 4,096 levels 
directly relate to the claim that vertical height measurement resolution is 100 times better 
than the grating pitch. If there are fewer levels available for digitization, the measurement 
resolution is proportionately reduced. 

The manual lens iris should be adjusted so that maximum sample brightness is just 
below the saturation level of the digitizer. This is generally sufficient when the illumination 
and diffuse reflectivity of the surface is uniform across the sample. However, when the 
sample contains regions of high and low reflectivity, the fringe intensity signals from the 
two regions each cover only a small amplitude at the extreme high and low ends of the 
digitization range. In order to encompass both the dark fringe pixels in the low reflectivity 
region and the bright fringe pixels in the high reflectivity regions, each of the two signals 
spans a smaller range of digitization levels and the vertical displacement resolution in 
each region is reduced. 

Painting the surface is the simplest procedure to eliminate this problem. If the surface 
cannot be painted, useful phase and displacement information can still be obtained for 
many samples, but the resulting loss of precision should be kept in mind. 
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Appendix A - Miscellaneous Information 

A.1 File Formats 

Akrometrix Surface Measurement saves data in a format with extension *.akx_phase 
or *.akx_disp. These files should automatically be associated and can only be opened 
with the Surface Analysis application. Other image file formats can be exported from the 
program but cannot be loaded back into any Akrometrix software. Image export formats 
include: *.png, and *_ph.tif. Lastly, recipe files are saved and loaded in the *.akx_recipe 
format. 

A.1.1 Metadata Fields 

Metadata fields embedded in *.akx_phase or *.akx_disp objects can be used in 
building filenames, output paths, and report labels in various places in Akrometrix Studio 
applications. Some of the more commonly used metadata fields are described below. 

<RoiName> User defined when adding ROIs to the Camera Window. Also defined when 
partitioning in Surface Analysis. 

<LotId> User defined in the Metadata window (Error! Reference source not 
ound.) 

<TestId> User defined in the Metadata window (Error! Reference source not 
ound.) 

<OperatorId> User defined in the Metadata window (Error! Reference source not 
ound.) 

<ProductId> User defined in the Metadata window (Error! Reference source not 
ound.) 

<TemperatureNominal> User defined when creating a profile in Profiler Generator 

<TemperatureReading> Any thermocouple data for the acquisition (can include up to 16 
temperatures in the case of a CRE measurement). With no suffix, this 
metadata tag will provide TC1 data, but a two digit numerical suffix, such as 
“02” will provide the data for the corresponding thermocouple. 

<TemperatureSetpoint> User defined when creating a profile in Profile Generator 

Other metadata fields such as Pin 1 Location, Equipment Model, etc. are available 
by right clicking on any phase or displacement image and going to Properties…. Any 
entry in this list can be surrounded by “<” “>” symbols to indicate to the application to use 
that metadata field in populating the corresponding text entry area. In addition, any gauge 
value can be added in the same way. 

A.2 Keyboard Shortcuts 

F3 Toggle Fill ROI behavior 

F5 Bring Camera Window to foreground (will not hide Camera Window) 

F6 Show/Hide Sample Height Window 

F7 Show/Hide Camera Control Window 

F12 Perform an Acquire (capture data) 
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Ctrl+R Add new ROI 

Ctrl+V Paste copied ROI 

Ctrl+T Open Thermal Profiler application 

Ctrl+S Save as *.akx_* 

Ctrl+I Save as image 

Ctrl+W Close 

Ctrl+O Open in Surface Analysis 

While the ROI has focus the following keyboard shortcuts apply: 

Ctrl+5 make ROI its maximum size. 

Alt+5 make ROI half of maximum size and position in center of field of view. 

Ctrl+C Copy size, shape, and location of selected ROI 

Up Arrow or 8 on NumPad Move ROI up one pixel 

Down Arrow or 2 on NumPad Move ROI down one pixel 

Left Arrow or 4 on NumPad Move ROI left one pixel 

Right Arrow or 6 on NumPad Move ROI right one pixel 

1 on NumPad Move ROI down one pixel and left one pixel 

3 on NumPad Move ROI down one pixel and right one pixel 

7 on NumPad Move ROI up one pixel and left one pixel 

9 on NumPad Move ROI up one pixel and right one pixel 

Ctrl plus any of the above will increase the ROI size in the desired direction. 

Alt plus any of the above will decrease the ROI size in the desired direction. 
 


